
United States Department of Agriculture 
Forest Service 
Rocky Mountain Research Station 
Boise Aquatic Sciences Lab 
 

 

The Geomorphic Road Analysis and 
Inventory Package (GRAIP) Office 

Procedure Manual 
 

Richard M. Cissel, Thomas A. Black, Kimberly A. T. Schreuders, 
Charles H. Luce, Ajay Prasad, Nathan A. Nelson, David G. Tarboton  

2011 Edition 



 

  



 

THE GEOMORPHIC ROAD ANALYSIS AND INVENTORY 
PACKAGE (GRAIP) OFFICE PROCEDURE MANUAL 

 

Richard M. Cissel, Thomas A. Black, Kimberly A. T. Schreuders, Charles H. Luce, Ajay 

Prasad, Nathan A. Nelson, David G. Tarboton,  

 

Current as of January 6, 2011 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Support 
 

We are interested in feedback. If you find errors, have suggestions, or are interested in 
any later versions contact: 

 

David G. Tarboton 

Utah State University 

4110 Old Main Hill 

Logan, UT 84322-4110 USA 

Email: dtarb@cc.usu.edu 

http://www.neng.usu.edu/cee/faculty/dtarb/

index.html 

 

Tom Black 

Rocky Mountain Research Station 

 322 East Front Street, Suite 401 

Boise, Idaho, 83702 USA 

Email: tblack@fs.fed.us 

http://www.fs.fed.us/GRAIP/index.shtml 

 

Commercial Endorsement Disclaimer 

The use of trade, firm, or corporation names in the publication is for the information and 

convenience of the reader. Such use does not constitute an official endorsement or 

approval by the U.S. Department of Agriculture of any product or service to the exclusion 

of others that may be suitable.



Table of Contents 
 

INTRODUCTION: THE GRAIP METHOD ..................................................................... 2 
This Manual .................................................................................................................... 2 
Road Inventories and the General GRAIP Method ........................................................ 3 
The Steps ......................................................................................................................... 5 

Necessary Software and ArcMap Toolbars .................................................................... 6 
Necessary GIS Skills....................................................................................................... 9 
Organizing Your Files..................................................................................................... 9 
Tips and Tricks for ArcGIS 9 ....................................................................................... 11 

SECTION I: FROM FIELD DATA TO GIS SHAPEFILES ........................................... 15 

Transferring Field Data into Pathfinder Office ............................................................. 15 
Differential Correction .................................................................................................. 22 

Exporting Data as Shapefiles ........................................................................................ 29 
SECTION II: PRE-PROCESSING ................................................................................... 34 

Preparing the DEM ....................................................................................................... 34 
Preprocessing Shapefiles .............................................................................................. 41 

Editing Data Errors ....................................................................................................... 48 
Straightening Road Lines .............................................................................................. 61 

SECTION III: RUNNING THE GRAIP MODEL ........................................................... 72 

Running TauDEM ......................................................................................................... 72 
Running SINMAP ......................................................................................................... 77 

The GRAIP Toolbar Menus .......................................................................................... 87 
Preprocessing ................................................................................................................ 90 
Road Surface Erosion Analysis .................................................................................... 95 

Mass Wasting Potential Analysis................................................................................ 101 

Habitat Segmentation Analysis ................................................................................... 119 
Appendix A: An Example File Management System ..................................................... 121 
Appendix B: More Details About The GRAIP Preprocessor and Toolbar Functions .... 122 

GRAIP Preprocessor ................................................................................................... 122 
Preprocessor Menu and Associated Functions........................................................... 122 

Road Surface Erosion Analysis Menu Functions........................................................ 123 
Mass Wasting Potential Analysis Menu and Associated Functions ........................... 125 
Habitat Segmentation Analysis Menu Functions ........................................................ 128 

Appendix C: Terminology .............................................................................................. 129 

GIS Terms ................................................................................................................... 129 
GRAIP Terms ............................................................................................................. 130 

Appendix D: Attribute Table Field Name Explanations................................................. 133 

Appendix E: Examples Of The GRAIP-Created Grids .................................................. 139 
Release Notes .................................................................................................................. 143 
References ....................................................................................................................... 144 



 

 2 

INTRODUCTION: THE GRAIP METHOD 

 

 This introduction aims to describe, in a general sense, how this manual is 

organized and how to use it, what the steps to the data processing portion of a GRAIP 

study are, and how to keep the many files involved in this process organized. 

Specifically, this introduction will describe what software and ArcMap toolbars you will 

need to run the model, and what GIS skills are necessary to have before you begin the 

analysis. A section on ArcGIS 9 tips and tricks is also included. 

 

 

This Manual 

 

 This manual is part of a set of documents that describe all steps of a GRAIP 

study, from collecting data in the field, to this office analysis manual, to a tutorial that 

will give you a better idea of how the model works. 

The aim of this manual is to provide a set of fairly specific instructions for all 

parts of the office portion of a GRAIP analysis. It is organized in the order in which the 

steps are best completed and grouped in sections that contain steps towards a similar 

goal. There are three main sections in the manual, organized to reflect the three main 

steps of the office analysis, outlined below. Screen shots are included in order to reduce 

confusion. 

The best approach is to read though all of the section and sub-section 

introductions in order to get a complete picture of how the process will progress before 

beginning the analysis. Read the entire sub-section before you begin, so you have an idea 

of the results and goals of that sub-section. 

There are some conventions used in the manual that warrant explanation. Some 

terminology definitions are described in Appendix C. Italics indicate the title of an option 

in a menu or toolbar (e.g. File and Road Surface Erosion Analysis), a field in a window 

or column in an attribute table (e.g. Drain Points Shapefile and SedProd), or a button in a 

window inside ArcMap or an associated program (e.g. Add and Compute). An effort has 

been made to capitalize the same words that are capitalized in the various menus, titles, 

etc. involved in the process. The symbol -> is used to indicate a series of steps that do not 

need further explanation (e.g. click This-> click That-> navigate to file X-> click Add, 

etc.). Generally, a specific series of steps is only described in detail the first time because 

it is assumed that you will be following the steps consecutively. Figures are numbered 

and captioned only in the parts of the manual that are not step-by-step because the figures 

used to illustrate each step donôt need further clarification. Finally, ñdemò is used to 

represent the name of a generic DEM so that it is easier to refer to grid files based on the 

DEM with new extensions. 

This update includes more details on running the model with certain calibrations 

(slope stability and gully risk), more details about how the model works (Appendix B), 

and some changes to the process to make certain steps easier, faster, or more accurate. 

Additionally, the function of the model has changed slightly to no longer include fish 

habitat patch information (this feature was time consuming, and its information could be 
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gleaned more easily from other sources). Fish passage barrier modeling is retained for 

optional use. 

 

 

Road Inventories and the General GRAIP Method 

 

An important first step in managing forest roads for improved water quality and 

aquatic habitat is the performance of an inventory (USDA Forest Service 1999). Methods 

for making a comprehensive inventory of forest roads and analysis of that inventory for 

watershed analysis are needed. The design of such methods must consider how roads 

affect the hydrology and water quality in forested watersheds (McCammon et al. 1998). 

The hydrologic and geomorphic effects of forest roads are closely linked to the 

linear nature of roads. Roads have a tendency to capture water and discharge it in one 

location. They may also route water across topographic gradients, redistributing and 

concentrating the flow and thereby increasing the probability of landslides, gully 

formation and sediment transport below the road drains (Megahan and Ketcheson 1996, 

Flanagan et al. 1998, Montgomery 1994, Wemple et al. 1996, Luce and Wemple 2001). 

Beyond the rerouting of water, roads also directly contribute sediments eroded from their 

surfaces to water bodies (Washington Forest Practices Board 1995, Cline et al. 1984, 

Megahan 1974, MacDonald 1997, Luce and Black 1999). The fundamental 

considerations in the design of a road inventory and analysis procedure for assessing 

watershed related effects of roads should focus on the questions; 1) Where are runoff and 

sediment generated or intercepted by roads, and 2) Where do the water and sediment go? 

The inventory and analysis methods detailed in this document were designed with 

these principles in mind. It is expected that the GPS and GIS will be the primary tools in 

the implementation of the inventory and analysis. Because there are errors in location 

information from GPS and in digital elevation models, some redundancies are built into 

the procedure to ensure that water movement is specified in the field.  

 There are two general scales at which to apply the GRAIP method. The preferred 

appraoch is to inventory an entire watershed at once, with the goals of determining where 

road problems are located, so that they can be fixed, and of determining how much extra 

sediment and mass wasting risk is associated with the road network in that watershed 

(e.g. Fly et al. 2010, Nelson et al. 2010B). The secondary way is to apply GRAIP on a 

small scale as a project monitoring tool. A road or set of roads is inventoried before and 

after a road treatment (such as decommissioning or water-bar installation) in order to 

determine the effectiveness of that treatment (e.g. Black et al. 2009, Nelson et al. 2010A). 

In this second method, untreated control roads that have similar properties to the 

treatment roads are also inventoried so that the effectiveness of the treatments can be 

gauged by re-inventorying all of the roads after a large storm event. Updated reports and 

more information can be found on the GRAIP website 

(http://www.fs.fed.us/GRAIP/index.shtml). 

The primary goal of a road sediment inventory is to document the sources of 

sediment and how they interact with the road and are ultimately routed to the hillslope 

and stream network. It is useful to break the road drainage system up into three 

components. We examine the road prism and ditches as one component of the system, 
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where much of the water and sediment are generated. Points where the flow is diverted 

off of the road are examined as the second component to determine where they occur and 

how they function. The third component examines the type of surface and flow path 

where the water is discharged below the road drain point. Basic information about the 

hillslope flow path below the discharge point will allow us to make inferences about the 

sediment delivery to nearby streams.  

This method is designed to quantify the rate of surface erosion related to overland 

flow of water. It can also be used to assess the risk of mass movement and gullying. The 

GRAIP inventory also provides an updated map of the extent of the road network and an 

inventory and condition map of road assets such as culvert pipes, water bars, gates, and 

road closures. It is possible to use this inventory opportunity to provide a first order 

assessment of fish passage potential at stream crossing culverts (Washington State 

Department of Fish and Wildlife 2000). Significant improvement in fish passage 

assessments may be achieved by application of a more thorough inventory and analysis 

procedure such as Fish Xing (Six Rivers Watershed Interactions Team 1999). 

When a road inventory is conducted for watershed analysis, the road network will 

likely include multiple ownerships. The quality and extent of available data on roads may 

vary dramatically by ownership and region. Due to these limitations of data availability 

on forest roads and their hydrologic properties, we have chosen to utilize a GPS device to 

collect the location information on point and line features associated with the road 

network. Predictions of road sediment production are made for each road segment 

utilizing the information on road attributes, condition, length and slope. These predictions 

are made based on either locally collected sediment plot data for typical road segments 

(Luce and Black 1999, Luce and Black 2001) or values from comparable regions 

available in the literature (Megahan and Kidd 1972, Megahan 1974, Reid and Dunne 

1984, Swift 1984, Bilby et al. 1989, Ziegler et al. 2001). An outline of a simple method 

for setting up local road erosion plots is available (Luce and Black 1999). 

The road network is divided into road line segments, where the entirety of that 

road segment shares the same condition attributes. The data dictionary used in field data 

collection allows for a thorough documentation of the parameters of the road (Black et al. 

2010). The attributes of the road line, such as the surface type and surface vegetation 

percent, are divided into classes in the appropriate menu. The road line is ended and a 

new segment begins when a new drain point is encountered, a grade reversal occurs, or 

one of the attributes changes from one class to the next. The road line describes three 

types of information; 1) on which part of the road is concentrated flow traveling (flow 

path, e.g. ditch location), 2) the drainage feature receiving discharge from that road 

segment, and 3) the physical condition of the road prism. At each road drainage feature, 

evidence is collected documenting the ultimate destination of the water as it encounters 

the hillslope. Each drain point is associated with the contributing road segments using the 

time stamp given when the drainage feature is opened. 

Road inventories completed in this manner are a valuable tool for prioritization of 

road maintenance and watershed restoration efforts. They are probably one of the least 

expensive tools applied to the problem of road maintenance and restoration. Engineers 

from federal agencies and private forestland companies have eagerly used data collected 

with these methods for many projects. 
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The Steps 

 

 There are three main groups of steps in the data processing portion of a GRAIP 

study. Each group is organized in the three Sections, and can generally be completed on 

its own. First, the field data must be made into GIS shapefiles. The field data is imported 

into Pathfinder Office (discussed below), where it is differentially corrected to remove 

atmosphere-related GPS error, and then exported as GIS-ready shapefiles.  

 Next, the shapefiles and the DEM must be preprocessed for GRAIP. The DEM 

must be clipped to watershed boundaries, the DrainPoints and RoadLines shapefiles used 

by GRAIP for analysis must be created, and their errors corrected and road lines 

straightened. 

 Finally, the actual GRAIP analysis can begin. TauDEM and SINMAP are used to 

create a series of grids and shapefiles that are used by GRAIP. SINMAP is used to create 

a series of grids used both for the mass wasting analysis step and for comparison, so that 

the affect of the roads on slope stability can be assessed. There are three main groups of 

GRAIP functions in the analysis, found in the GRAIP toolbar. The first group calculates 

the sediment production, and its accumulation at drain points, as well as its delivery and 

accumulation in the streams. The second set of GRAIP functions analyzes the impact of 

the road drainage on terrain stability. A grid similar to that produced by SINMAP, but 

which takes the water from the roads into account and illustrates slope stability, is 

produced for comparison, as well an index number at each drain point that indicates the 

likelihood of gullying at that drain point. The last function analyzes the potential 

blockage of fish passage at stream crossings. There is more information about what 

exactly each step and series of steps does available in Appendix B. 

 Generally, a GRAIP analysis must be completed in the order presented in the 

GRIAP toolbar. However, certain steps of this process can be completed out of order. 

Also, there is an additional complication involving the Combined Stability Index step, 

which is presented and explained on the text. You may want to check the quality of the 

incoming field data daily or weekly, so that a field crew can return to fix any errors that 

cannot be resolved in the office. You may also want to get as much data ready for GRAIP 

analysis as possible, but not run the analysis because more data is being collected that 

will be added to the already collected data. The first thing you must do before anything 

else is turn the field data into shapefiles. From there, you can straighten the road lines 

directly or you can run the GRAIP Preprocessor and correct the errors you find, first. If 

you are conducting a watershed-wide study, it is recommended that the data be checked 

for errors and corrected frequently, so that any errors that are irreconcilable in the office 

can be re-visited by a field crew. You can also run TauDEM and SINMAP separately, 

after clipping and preparing the DEM. If you do this, make sure your file system doesnôt 

change before the rest of the analysis is begun. It is a good idea to complete all of the 

GRAIP toolbar analysis steps at once. 
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Necessary Software and ArcMap Toolbars 

 

 A GRAIP analysis requires a number of software packages that are not included 

with the GRAIP download. You must be running Windows 2000 or newer to install a 

number of these packages. All pieces of software should be installed before GRAIP is 

installed. You will need ArcGIS 9.2 or 9.3 with the ArcInfo and Spatial Analysis 

licenses, Trimble GPS Pathfinder Office 4.0, TauDEM, SINMAP 2.0, Hawthôs Tools, 

and finally the GRAIP Toolbar and GRAIP Preprocessor. The GRAIP set should be 

installed after everything else. Additionally, an internet connection is required for the first 

steps (Section I).  

For more information about obtaining and installing ArcGIS, see the ESRI 

website (www.esri.com). For more information on obtaining and installing Pathfinder 

Office, see the Trimble website (www.trimble.com/pathfinderoffice.shtml). ArcGIS must 

be installed prior to installing the rest of the toolbars. 

 There are five toolbars and a window that are standard to ArcMap (Figure 1). It is 

good to be familiar with them. The Main Menu toolbar contains general ArcMap 

controls, like Save and open ArcCatalog. The Standard toolbar contains buttons that 

generally do the same things as some of the options in the Main Menu, but are more 

conveniently located. The Tools toolbar contains buttons that control the mapôs extent, 

feature selection, and some other similar controls, many of which are also under the Main 

Menu, too. The Editor toolbar contains tools used to create and edit points, lines, and 

polygons in shapefiles. The Spatial Analyst toolbar contains the Spatial Analysis tools, 

such as the Surface Analysis tools and Raster Calculatoré. The Table of Contents 

window shows which layers are present in ArcMap, their symbology, their stacking 

order, and if they are visible or not, and allows you to change those aspects. You can see 

Figure 1. The six standard toolbars and window. Each of 

these can be dragged into the main ArcMap window. 

Click the toolbar header, and drag the window or toolbar 

to any edge of the screen until the window or toolbar 

outline changes from thick gray to thin black. 
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what a tool is called by hovering the mouse pointer over the tool until the label shows up. 

The area of the ArcMap screen that displays the map data is referred to as the map 

viewer. 

We recommend TauDEM 3.1, as newer versions may not be compatible with the 

other aspects of GRAIP. TauDEM 3.1 can be obtained from its website 

(http://hydrology.usu.edu/taudem/taudem3.1/index.html). Additional information and 

installation instructions are available there. Download the appropriate files and open the 

installation executable (extension .exe). Follow the on-screen instructions. Then, in the 

ArcMap Main Menu-> Tools-> Customizeé-> click on Add from fileé-> navigate to the 

location of the installation and click on agtaudem.dll-> click Open-> click OK to added 

objects-> scroll to 

Terrain Analysis using 

digital elevation 

models (TauDEM) 

under the Toolbars tab 

and check its box if it 

isnôt already checked-> click Close in the Customize window (Figure 3). The TauDEM 

toolbar should now be present in ArcMap (Figure 2). You should only have to do this 

once (i.e. when you open ArcMap again, the TauDEM toolbar should still be in the 

window. Other versions can be found at http://hydrology.usu.edu/taudem/versions.html. 

 Installing the remaining toolbars is similar. For SINMAP 2.0 (Figure 4), go to its 

website (hydrology.neng.usu.edu/sinmap2). There is substantial documentation on the 

website, if you desire to learn more. Download the appropriate file (SINMAP 2.0 

setup.exe) and open the file. Follow the 

installation instructions. In the ArcMap 

Main Menu, do as before. From the 

Customize window, add the file Figure 4. The SINMAP toolbar. 

Figure 3. The Customize... window, used for changing which toolbars are displayed and which tools 

are present in each toolbar. 

Figure 2. The TauDEM toolbar. 
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agSINMAP.dll, and check the box next to Stability Index MAPing(SINMAP). 

 For Hawthôs Tools (Figure 5), go to its website 

(www.spatialecology.com/htools/download.php). Hawthôs Tools are now out of date and 

replaced with Geospatial Modeling Environment, however Hawthôs is still available. The 

Tools work best with ArcGIS 9.3. There is additional 

information about the Tools on the website. Download 

and unzip the appropriate file. Open htools_setup.exe and 

follow the instructions. From the Customize window, add 

the file HawthsTools3.dll and check the box next to 

Hawthôs Tools. 

 For the GRAIP Toolbar and Preprocessor (Figure 6), go to the program website 

(www.neng.usu.edu/cee/faculty/dtarb/graip/) and download the appropriate files for the 

current version. Open GRAIPSetup.exe and follow the on-screen instructions. From the 

Customize menu, add the file agGRAIP.dll, and check to box next to Geomorphic Road 

Analysis and Inventory Package(GRAIP). Additional information and updates can also be 

found at the main GRAIP website (http://www.fs.fed.us/GRAIP/index.shtml). 

The GRAIP Preprocessor and the tutorial package are also installed in the same 

directory as the rest of the GRAIP package. Additionally, the binary libraries 

consolidateShp.dll and graipCOMDLL.dll are installed. These files and agGRAIP.dll 

make up the Preprocessor and Toolbar. The GRAIP database template, GRAIP.mdb, is 

also installed for use by the Preprocessor. 

The version of GRAIP.mdb that is included 

with the GRAIP download above is 

compatible with the data dictionary (which 

is what is used for field data collection) 

INVENT 4.2. The latest (at time of writing) 

data dictionary is INVENT 5.0, which is 

available at the Forest Service GRAIP 

website 

(http://www.fs.fed.us/GRAIP/downloads.sht

ml), along with updated versions of 

GRAIP.mdb. The tutorial folder contains 

the tutorial manual and a zipped data file 

that contains the ñdemoò folder which 

contains all of the tutorial data (the DEM 

called dem, and a shapefiles folder that 

contains BBdip.shp, Diffuse.shp, 

Ditchrel.shp, Lead_off.shp, ned.shp, 

Str_Xing.shp, sump.shp, waterbar.shp, and 

road.shp). In order to follow the tutorial, 

you need the tutorial files. Unzip them to a 

good working directory. A shortcut to the 

Figure 5. The Hawth's 

Tools toolbar. 

Figure 6. The Extensions window. The Spatial Analyst 

extension is highlighted. 

Figure 7. The GRAIP toolbar. 
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GRAIP Preprocessor is installed in the Windows Start menu. 

The ArcGIS Spatial Analyst extension must be unlocked so that GRAIP can use 

certain features (Figure 7). From the ArcMap Main Menu, Tools-> Extensions-> check 

the box next to Spatial Analyst-> click Close. If the Editor and Spatial Analyst toolbars 

are not present in the ArcMap window, check the boxes next to them in the Toolbars tab 

of the Customize window from above. 

 

 

Necessary GIS Skills 

 

 It is helpful to have basic GIS skills before you use the GRAIP tools, but not 

necessary. This manual assumes a novice GIS skill level so that more people will be able 

to use it. Most basic processes are explained in enough detail so that someone who has 

never done that process before will be able to without trouble. It is best to at least know 

the general layout of ArcMap and ArcCatalog, and have a reasonably high level of 

computer literacy. It is helpful to be comfortable with defining and changing projections, 

using the Editor toolbar to edit shapefiles and their tables, and changing the symbology of 

layers in ArcMap. Also, it is good to be comfortable with using the tools in ArcToolbox, 

and moving and making copies of layers, and creating new workspaces in ArcCatalog. 

 

 

Organizing Your Files 

 

 File organization is an important component of any GIS task, and a GRAIP 

analysis is no exception. There are multiple stages of the same basic data, and many files 

are created and modified during the process. Many of the files are very large, often 

resulting in very large workspaces. Even if you have multiple sets of roads in the same 

watershed (as you might if you are comparing a set of roads before and after they are 

worked on), you will want each set of data to have its own unique set of DEMs and other 

rasters (such as the TauDEM- and SINMAP-created files). It is recommended that you 

have a file system established before you begin analysis. 

Some guidelines are useful when creating your file system. First, whenever you 

want to create a new workspace, or move or copy a GIS file (shapefiles, grids), use 

ArcCatalog. This is much simpler and more reliable than the same tasks in Windows. 

You wonôt have to find all of the separate files that go into making one shapefile or grid. 

Second, do all of your work in ArcInfo Workspaces instead of regular folders. These can 

be created in ArcCatalog by right-clicking in the directory in which you want to create 

the workspace and choosing New-> ArcInfo Workspace (Figure 8). Keep in mind that you 

will have a hard time finding old data if you do not name everything clearly and 

consistently. Include a text file with your naming scheme and file system in the main 

workspace if you intend to store the data for long periods. Thirdly, as suggested above, 

create all of the necessary workspaces and structure before you begin analysis. This can 

reduce confusion later. It helps to write down all of the file paths in the file system for 

reference so you donôt have questions about what should have gone where. Fourthly, do 
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not put your files and workspaces 

directly on the C drive. Finally, 

TauDEM, SINMAP, and GRAIP 

all require that there are no spaces 

in any file paths that they need to 

use, and that all files that they use 

directly (shapefiles, grids) have no 

more than eight characters (your 

workspaces can have long names, 

but no spaces). The DrainPoints 

and RoadLines shapefiles are 

exceptions to this rule. Generally, 

if you are renaming a shapefile or 

grid, do not allow the name to have 

more than eight characters. It is 

recommended that you complete 

the metadata for your final grids 

and shapefiles for documentation 

purposes. 

 Each basic file system 

should have a working workspace 

that contains only and all of the 

files that apply to that particular 

site or area. In this workspace, you 

should have a copy of the DEM 

you are using, as you plan on using 

it (clipped, with the correct 

projection; see Section II) in its 

own workspace. Also under the 

working workspace, there should 

be a workspace for the shapefiles, 

as well as the files created by the 

GRAIP Preprocessor. TauDEM will save its files to the DEMôs workspace, and SINMAP 

will create its SINMAPData folder there. During the GRAIP process, there are some grid 

files that are created. Their default saving locations (to the DEMôs workspace) should be 

okay. An example file system can be found in Appendix A. 

 There are other systems possible, some of them probably simpler. The important 

part is that you understand your system. It is worth noting that, often in the GRAIP 

process, a file will be created that is used later in the process. If you move the location 

that the file is saved to, GRAIP will remember that as the default location for that file as 

long as that GRAIP file remains open. If you close and re-open ArcMap or otherwise 

have to re-open the GRAIP file, you will have to manually locate those files which were 

saved elsewhere than default. This applies to renamed files, too. Finally, if you are 

sharing this data with other people, it is easiest to export the GRAIP files (DrainPoints, 

RoadLines, demnet) as layer files so that the person on the receiving end does not need to 

use your file system or even have GRAIP installed. 

Figure 8. A completed GRAIP project and its file system. The 

DEM is called uma_w, and the other grids were created by 

TauDEM, SINMAP, or GRAIP. Also shown is the path to create a 

new ArcInfo Workspace. 
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Tips and Tricks for ArcGIS 9 

 

ArcGIS is a large and complicated set of programs. Tools donôt always work the 

way they should, or they may not work with your specific dataset for some reason. 

ArcMap and its toolbars can crash. Some small detail within the data can be wrong or 

corrupted, and the data wonôt 

work with the tools you need.  

GIS help and training is 

abundant, and usually very useful. 

There is a desktop help that comes 

with ArcGIS. Go to the ArcMap 

Main Menu-> Help-> ArcGIS 

Desktop Help. ESRI has an 

extensive online help section, 

accessible from the Help menu or 

via the ESRI website 

(www.esri.com). The ESRI 

website also has some training 

options. Here are some tips and 

tricks for using GIS in general, as 

well as a couple of specific 

examples that apply to a GRAIP 

study. Remember, patience is a 

virtue!  

 First, there are some usability tricks. The GRAIP process uses a lot of toolbars 

that you will probably want to display all at once. If your screen resolution is too low, 

you might have to move toolbars around to make the most efficient use of your screen 

space at any one time. To increase the screen resolution, go to the computer desktop-> 

right-click-> Properties-> Settings tab-> Screen area field-> slide the bar over towards 

More-> click Apply-> click OK-> click OK 

(Figure 9). This process is slightly different 

from computer to computer, depending on the 

operating system, etc. 

The individual tools that are available 

in the Standard toolbar and Tools toolbar are 

customizable (Figure 10). In order to 

customize which tools are displayed, go to 

the ArcMap Main Menu-> Tools-> 

Customizeé-> Commands tab. From here, 

you can navigate through the Categories and 

drag the Commands you want to the 

appropriate toolbar. Some useful commands, 

where the underlined commands are not in 

Figure 9.  The Display Properties window on a Windows XP machine. 

Figure 10. The Commands tab of the Customize... 

window. Some useful tools are displayed under the 

Selection category. 
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the toolbars by default, are, Zoom In/Out, Fixed Zoom In/Out, Pan, Zoom Full Extent, 

Go To Previous/Next Extent, Clear Selected Features, Pan To Selected Features, Zoom 

To Selected Features, Identify, and Measure in the Tools toolbar, and New Map File, 

Open, Save, Delete, Add Data, ArcCatalog, ArcToolbox, and Add Image Service (for 

Forest Service users; available online at 

http://fsweb.rsac.fs.fed.us/imageserver/imageserver.html) in the Standard toolbar.  

There are times when there is a certain sub-full extent is useful to be able to return 

to, such as if you have a regional background image displayed, and you want to zoom to 

the relatively small watershed you are working in. You can create an extent bookmark. 

Go to the ArcMap Main Menu-> View-> Bookmarks-> Createé-> type a name-> click 

OK. To use the bookmark, go to View-> Bookmarks-> click on the bookmark name. In 

ArcCatalog, you may need to refresh a window before the modifications you have made 

in ArcMap (such as the creation of new shapefiles) show up. Right-click in the directory-

> Refresh. 

 One of the most important things you can do is save your work often. However, 

you do not usually need to save the map file, because changes made to individual 

shapefiles and their tables are made directly to those. If you are editing a shapefile, save 

the edits in the Editor toolbar frequently (Editor-> Editor drop-down-> Save Edits). 

When you create a new shapefile or grid, it is saved on the hard drive. On a related and 

more important note, back up your data at least once daily. The back-up file system 

should be the same as the working file system. 

 Data projections are sometimes tricky. It is important to have all of the data in the 

same projection, whether or not that projection is defined. If the data was exported to 

shapefiles in the wrong projection, it will likely not be registered correctly with the DEM 

or background image, and you will have to re-project it into the correct projection (see 

Section II). If the DEM is in the wrong projection, you may re-project it, but make sure to 

use the correct technique (see Section II). ArcMap attempts to ñproject on the fly,ò where 

the first layer added to the map file defines the projection for everything else that is 

added, but only if what is added does not have a defined projection. When you open a 

new map file, the projection of the viewer is reset. Whenever you change or define the 

projection of a shapefile or grid, open a new map file and re-add those layers. Open a 

new map file whenever you change the dataset you are working with (as opposed to 

removing the layers in the map and adding new layers). You will probably encounter 

messages about data you are adding or editing being in the wrong projection, or not 

having a defined projection. Usually, you can ignore those. If you encounter another 

problem and you have encountered one of those messages in regards to a layer you are 

working with, the projection/ projection definition is the first thing you should check and 

fix. To check this, right-click in the layer name in the Table of Contents in ArcMap-> 

click Layer Properties to open the Layer Properties window for the layer-> Source tab-> 

scroll down to Spatial Reference, expanding the line if necessary. 

 If you encounter a problem with a tool in ArcMap or a toolbar, try it again. If it 

still does not work, close ArcMap, delete any file it might have started to create in 

ArcCatalog (this will look like whatever file the tool was supposed to create), and re-

open ArcMap. Try it again. If the same problem occurs, delete any file the tool may have 

started to create, close all programs, restart the computer, and try it without ArcCatalog 

open. If the problem persists, there is some conflict with the tool and your data, with the 
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tool and ArcGIS, etc. Seek additional help. If you look in the desktop help or online, look 

up the tool to see if it has any special requirements that are not met by the input data (e.g. 

the tool might require all projections to be defined). If ArcCatalog is open, make sure that 

the directory that is displayed is not the same directory you are working under in 

ArcMap, or things will get confused. Often, it is best to not have ArcCatalog open at all 

when working in ArcMap. 

 Restarting ArcMap works at least half the time. In fact, it is a good idea to restart 

the ArcGIS components on a regular basis as a preventative measure. Keep in mind that, 

if you restart in the middle of the GRAIP process, and the grids are being saved to a non-

default location or have non-default names, GRAIP wonôt remember, and you will have 

to specify the name/location of a particular file yourself. As you go along with multiple 

data sets, you might find that there are certain errors that repeat themselves, either 

because there is a common problem with the data, or a problem with the tool (or how the 

tool relates to the your data type, etc.). Note what the solution to these problems are, and 

repeat that each time. If you locate a problem with GRAIP, please email Tom Black at 

tblack@fs.fed.us. We will attempt to aid in finding a solution and will add it to our FAQ. 

 The first example of an error occurred with the Combined Stability Index function 

in the GRAIP toolbar (see Section III). This function uses some inputs that were created 

with SINMAP, and outputs a grid file. All inputs would be correctly specified and 

located, but when the function was executed, it would come back with an error. Re-

opening ArcMap and restarting the computer did not help. There was no partial file 

created. However, the DEM that was used had been re-projected incorrectly, and so an 

error was generated before the output grid file was even created. The solution was to go 

back to the original DEM (before the re-projection), which had been saved, and re-project 

it using the correct method, and then re-run the GRAIP Preprocessor and all of the 

GRAIP toolbar functions to that point (see Sections II and III). This is a good example of 

a user-caused error, and one that is all too easy to do. 

 The second example of an error occurred in SINMAP, during the final step. This 

happened with the same incorrectly re-projected DEM as above. SINMAP needs to be 

run all in the same session. The error occurred when Compute All Steps under the 

Stability Analysis menu in the SINMAP toolbar was initiated. ArcMap would freeze, and 

a Windows End Task dialog would appear. The initial solution was to click End Task, go 

into ArcCatalog and delete all of the already-created grids (in previous SINMAP steps), 

and then re-run all of the SINMAP functions. This happened twice before SINMAP fully 

worked. However, this was not a very good solution. The errors in the DEM that were 

generated by the incorrect re-projection were the cause of this error, and the series of 

restarts and deletes were only good luck. A better solution was to do the same as aboveð

correctly re-project the original DEM. This better solution was not discovered until the 

first error example had happened, and the correctly projected DEM got through SINMAP 

without any errors. 

That last example illustrates that a solution such as closing and re-opening 

ArcMap is often just a Band-Aid for some other problem that has a better solution. 

However, it is often difficult to pin-point that other problem, so finding the better solution 

is impractical. The Band-Aid restart is usually good enough. If that is the solution you 

pursue, you should pay extra careful attention to the output data from that point forward 
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to ensure that all of the data makes sense and no unforeseen errors or inaccuracies have 

occurred. 



 

 15 

SECTION I: FROM FIELD DATA TO GIS SHAPEFILES 

 

 This section describes the first step in a GRAIP study; changing the data from the 

format used by the GPS systems in the field to the format used by ArcGIS. The data must 

first be brought into Pathfinder Office with the correct format. Next, a differential 

correction is performed using downloaded base station data in order to remove data 

points that have very low precision (an internet connection is required for this step). 

Finally, the differentially corrected files must be exported into their final format, which is 

the GIS shapefile. These instructions are for Pathfinder Office 4.0. Other versions may be 

different in some respects. 

 

 

Transferring Field Data into Pathfinder Office 

 

 Data is collected in the field with the Trimble TerraSync software. Data is saved 

as a set of eight or nine files with the extensions .car, .dd, .gic, .gip, .gis, .giw, .gix, .obs, 

and .obx (the file with extension .car does not exist if there are eight files; Figure 11). The 

default naming theme that TerraSync uses includes the date and 

time that the file was created (for example, R071215A was 

created on 7/12 at 3 pm). An example of a TerraSync file might 

be R071215A.gic. In order for these files to be usable in 

Pathfinder Office, their format must be changed to the SSF (file 

extension .ssf) from that set of files. This is accomplished by 

transferring the data into Pathfinder Office. 

 There are a number of devices that can be used for field 

data collection, from laptops to small handheld field PCs. The 

methods for retrieving data from each of these devices are 

different, and so are not explained here. It is assumed that all of 

the data is accessible from the computer you are using. You 

will need all eight or nine TerraSync files, depending on how 

many are created by default with your particular field data 

collection device. 

 It is important to keep the raw data and Pathfinder Office files organized so you 

know where to look in the future. You should keep these data in a folder separate from 

the ArcGIS workspace, and, if you have multiple sites, or will have multiple sites 

sometime in the future, each site should get its own sub-folder (a site might be all roads 

in a watershed, or the roads in a road decommissioning study before they have been 

worked on, with a second site for after they have been worked on). You should keep a log 

of every TerraSync file and what part of which road each file contains. 

 

1. Move or copy all of the relevant raw data into whichever folder your want to use. 

Figure 11. All 

nine possible 

TerraSync files. 
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a. Relevant data are all eight or nine TerraSync files for each file name 

(R071215A.gic, R071215A.dd, etc.). 

b. Keep the raw data separate from the GIS workspace. 

2. Open Pathfinder Office. 

a. Go to the Windows Start menu-> Programs-> GPS Pathfinder Office (version 

number)-> click on GPS Pathfinder Office to open. 

3. Select the project folder. This is the place where all of the files that Pathfinder Office 

creates will be saved. 

a. If the Select Project window does not automatically open, go to File-> Projectsé. 

b. If you are working with an already created project, use the Project Name drop-

down menu to select it and click OK. Skip ahead to step 4. 

c. If you do not have a folder set up for the current project, you must set one up now. 

Go to Newé. 
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i. Next to the Project Folder field click Browseé-> navigate to the location of 

the raw data files-> click on the folder that contains those files-> click OK. 

ii.  The Backup Folder, Export Folder, and Base File Folder are subfolders 

automatically created in the project folder. Check to make sure they will be 

created in the same place by clicking Browseé next to one of those fields. 

iii.  In the Project Name field, enter a name that makes it clear which folder is 

referenced. 

iv. Click OK to create the project folder. 

- Click Yes if the error message that says, ñFolder already exists; Do you 

want to continue?ò pops up. 

d. Click OK to select the new project. 

4. Go to the main menu-> Utilities-> Data Transferé 

a. Pathfinder Office is set up to talk directly to whatever device you use to collect 

field data, but we do not want to do this. Instead, we want to use data already on 

the hard drive of the computer. These methods are un-intuitive because of this. 

b. Ensure that the Receive tab is selected. 
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c. If you already have the relevant folder connected, click on the Device drop-down 

to select it and skip to step d. If you do not already have the relevant folder 

connected, you will need to connect it. Click Devicesé 

i. Click Newé. 

ii.  Select GIS Folder as the type of device you wish to create-> click OK. 
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iii.  Click Browseé to navigate to and select the Project Folder (created above)-> 

click Next. 

iv. Use the drop-down menu next to Type to select TerraSync, and then select the 

Version closest to that used in the field-> click Next. 
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v. Give the device a short name (under nine characters) in the Name field-> click 

Finish. Click Close to close the Devices window. 

d. Click the Add drop-down in the Data Transfer window-> wait for Pathfinder to 

connect to the device folder if necessary-> click Data File. Select the relevant 

data files (only those with a .gis extension show up)-> click Open. Those files are 

added to the Files to Receive field. 

e. Click Transfer All. 
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f. The Transfer Completed dialog appears. This dialog will tell you if the transfer(s) 

was/were successful. You should check on the location of the transferred files by 

clicking More Detailséto access the log file and looking at each file path. The 

files should be transferred to the same directory as the raw data files. The format 

is converted to SSF (extension .ssf). There is a backup of the SSF file saved to the 

Backup folder in the project folder by default. Click Close when satisfied. Click 

Close to close the Data Transfer window. 

5. View the data to ensure that it is what you want. 

a. From the main menu, go to View-> Map. If necessary, select the SSF file(s) that 

you just created-> click OK. 



 

 22 

Differential Correction 

 

 GPS data contains many small errors due to factors associated with the satellite, 

such as its orbit being slightly off or interference from the atmosphere. Most errors of this 

type can be eliminated by performing a differential correction after the data has been 

collected (Figure 12). Differential correction uses data downloaded from a nearby base 

station to move and delete GPS points in error by comparing points from your data to the 

base station data. In this way, accuracy is improved. 

Not every error can be removed by differential correction (Figure 12). Many, if 

not most, errors that show up as zigzags in the road line will remain, and must be 

corrected by hand, 

as discussed later. If 

all of the positions 

that make up a 

feature (e.g. a road 

line) are 

uncorrectable, then 

the differential 

correction will 

remove the feature. 

There are some 

steps to take that 

ensure that this will 

not occur, and these 

are discussed below. 

An internet 

connection is 

required for this step in order to use the most up-to-date base station data. 

 

1. With the same project folder open as above, got to Utilities-> Differential 

Correctioné. 

Figure 12.  A section of road before (right) and after (left) differential correction.  

Areas where the differential correction changed the road line are noted. 
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2. The Differential Correction wizard appears. 

a. If the correct files do not appear in the Select SSF files to correct field, click the 

plus sign-> navigate to and select the relevant files-> click Open. If the incorrect 

files appear, in the Select SSF files to correct field, select them and click the X 

below the plus to remove them. Click Next when finished. 

i. Below the Select SSF files for correction window, there is some information 

about the file. 

- Date and time range of collection, location on the hard drive, number of 

GPS positions in the file, and whether or not the file was collected using 

an H-Star GPS receiver (H-Star allows for greater accuracy). 

ii.  You should only correct multiple files if they are geographically near (within 

about 50 miles), because it is necessary to use a nearby base station. 

b. If the data was collected with an H-Star receiver, select Automatic H-Star Carrier 

and Code Processing. If the data was not collected with an H-Star receiver, the 

options under H-Star will be grayed-out. If that is the case, select Automatic 

Standard Carrier and Code Processing. Click Next. 
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c. The settings on the next screen can be adjusted by clicking the Change button. 

We want to ensure that differential correction does not remove any feature 

because that featureôs positions cannot be corrected. 
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i. Click Change-> click the Output tab-> under Output Positions, ensure that the 

radio button next to Corrected and Uncorrected is selected-> click OK-> click 

Next. 

ii.  You should only have to do this one time, as these settings are saved. 

However, since missing this step could result in the loss of data, it is a good 

idea to check this setting about once per day that you use the differential 

correction. 

d. Click Select next to the Base Provider Group field. 
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i. This window looks different if your data was collected with a receiver that is 

not H-Star enabled, but the process is similar. If this is the case, you will click 

Select next to the Base Provider Search field, and skip ahead to step iii, 

below. 

ii.  If you have an appropriate group already, select it from the Base Provider 

Group drop-down menu, check to make sure the selected base station is still 

the best option (plus sign-> Update List), and skip ahead to step iii . If you do 

not already have an appropriate group, click Newé next to the Base Provider 

Group drop-down menu. Name it something obvious-> click OK. 

iii.  Click the plus sign. A list of base stations appears, with their distance from the 

data and an integrity index (higher is better).  
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- Click the Update List button to acquire the latest list. The Downloading 

base providersé window appears while the download is taking place.  

- Generally, the CORS base stations are the best choice. Select a nearby 

base station, with a relatively high integrity index and a bias towards 

CORS stations. If you have H-Star data, you can select multiple base 

stations. The more base stations you select, the longer it takes to complete 

the differential correction, but the greater are the chances of correcting all 

data. 

- Click the Propertiesé button to show some more information about the 

selected base station, such as the organization responsible for running the 

base station, and its precise location, in latitude-longitude and altitude. 

- Click OK to exit the Select Base Provider window. 

iv. Click OK to exit the Base Provider Group window.  

e. Select Use reference position from base providers in the Reference Position 

section of the window. Check the box next to Confirm base data and position 

before processing. Click Next. 

f. Select where you want the new corrected data file (extension .cor) to be saved and 

how you want it to be named. Click Start. 
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i. If base data cannot be downloaded for some reason, click Back twice, select a 

different base station, and try again. 

ii.  Click Confirm when required. 

g. When the process is complete, the window will say ñDifferential correction 

complete.ò You should look at the data in the window to confirm that the 

correction was successful. 

i. Useful data includes the number of positions corrected, the number 

uncorrected, which method (carrier or code) was used for how many 

positions, how many positions were thrown out, and estimated accuracies for 

the data. 

ii.  When finished, click Close. 
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Exporting Data as Shapefiles 

 

 The final data must be in the GIS shapefile format so that ArcMap and GRAIP 

can analyze it. The differentially corrected data files (extension .cor) are exported as 

shapefiles. The new shapefiles are saved by default to the Export folder in the project 

folder. You will want to either move, copy, or save them initially to a workspace for GIS, 

as discussed in the Introduction. Each single differentially corrected COR file turns into a 

set of shapefiles, one for each feature. Additionally, you can export multiple COR files at 

once, and they will all contribute their data to a single set of shapefiles. The number of 

shapefiles created depends on the data collected. For example, if the crew did not collect 

any ditch relief points, then there will not be any shapefile exported called DTCH_REL, 

which would contain the data for the observed ditch relief culverts. All of the possible 

shapefiles are BBASE_DI, DIFF_DRA, DTCH_REL, END_RD, EXCAV_ST, GATE, 

GULLY, LANDSLID, LEAD_OFF, NON_ENGI, PHOTO, Point_ge, REVISIT, ROAD, 

ROAD_CLS, ROAD_HZR, STRM_CRO, SUMP, and WATER_BA. Sometimes, data 

will be exported so that there are more than one of certain shapefiles (e.g. ROAD and 

ROAD2). This seems to be due to significant differences in collection dates or in the data 

dictionaries used for data collection. This does not have any effect on the processing of 

the data or its results. 

 

1. With the same project folder open as before, go to the main menu-> Utilities-> 

Exporté. 

2. The Export window appears. 

a. In the Input Files section, click Browse...-> navigate to the location of the 

differentially corrected file or files that you wish to export to shapefiles-> select 

the necessary COR files-> click Open. 



 

 30 

b. You can change the location of the output folder by clicking Browseé next to the 

Output Folder field. You may find it easier to use the final destination of the 

shapefiles (GIS workspace) for simplicity. Note that if you export to a location 

that already has GRAIP shapefiles in it, you will overwrite those shapefiles. 

c. In the Choose an Export Setup section of the window, choose Sample ESRI 

Shapefile Setup from the drop-down menu. 

d. Check the coordinate system in the area under GIS Coordinate System to make 

sure it is correct. If using UTM, make sure the zone is set correctly. Rectangular 

systems like UTM are best for this analysis. 
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i. If the coordinate system is not correct, click Propertiesé-> click the 

Coordinate System tab-> select Use Export Coordinate System-> click 

Changeé 
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- Use the drop down menus to select the appropriate coordinate system and 

associated properties-> click OK. 

iii.  In the Properties window, click the Position Filter tab. Under Include 

Positions That Are, ensure that Uncorrected is checked. 
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- This will export all features, including those which could not be 

differentially corrected.  

- This setting is saved, but, since missing this step could result in the loss of 

data, it is a good idea to check this setting about once per day that you 

export data. 

e. Click OK to export the file or files. 

f. The Export Completed window appears when the export is complete. This 

window shows how many features were in the initial COR file(s), and how many 

features were exported. There should be the same number of features before and 

after export. You can click More Detailsé to see exactly which files were created 

and where they are located in a log file similar to the log file created in the data 

transfer process. This text file is saved to the same folder as the exported files. 

Click Close when you are finished viewing the Export Completed dialog. 

3. Each shapefile is composed of a number of files that are readable by ArcGIS. Use 

ArcCatalog to move or copy the shapefiles into the appropriate GIS workspace if you 

did not save them there in step 2b above. Pre-processing can now begin. 
































































































































































































































